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eve you will add colors and patien
wilt learn what kinds of colors are suitable for printor
Web output. You will fill the inside of edge of an object
with a solid color or pattern using numerous nanels and
tools, save and organize swatches in the Swatches panel,
copy swatches between fles, choose stroke attributes,
use the Color Guide and Kuler panels, replace colors in
your artwork, irvert colors, colotize a grayscale image,
hiend fill colors between objects, and create and adit fi
patterns using the new Patiern Options panel.*ﬁi

Using color i illustrator

The fill, which is applied to the inside of an object or an
area in a Live Paint group, can be a soiih color, a pattam,
: or g gradient (or a color of Nonel. The stroke, which is

- “; : applied to an object's path, can be a solid color, a pattern
' (or Nongj, or @ gradient,ﬁ" and it can be dashad or
continuous. You can apply & hrush o an ohject’s stroke,
make a stroke Into an arrow, or as we describe on page
162, change the width profite. The path to which you
apply a fill and/or stroke can be open or closed.

The fill and stroke colors in the current of last selected
object—or new colors that you choose when no ohjecis
are selected — display on the Tools, Cotor, Control, and
Appearance panels.#& The two current colors are applied
to new objects automatically.

Saving colors as gwatches . ... . -

Choosing colors via the Color panel . 117

Continued on the following page ' Applying colors from a library. . o« - 118
Fili square Stroke}square Changing the tint percentage. ... . - 119
I I I {hanging the stroke weight,
alignment, caps, and joins. . oo - 120
Crealing amows . .o os st 121
Creating a dasied stroke .- oo 122
‘1 Using the Eyedropper ook, et 123
: Using the Swatches panel ... ..o 124
Using the Cotor Guide panet. ... 128
: Using the Kuler panel . ... oo v oo 131
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O 1 glending fill colors .« v s 134
ﬁ‘! :Zi)f;jz;i:;;;rsgig:d Creating a pattern .. ..o s 135
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in this chapter, you wilt use the Color, Swatches,
Color Guide, Kuler, Appearance, Pattern Options, and
library panels; the Color Picker; and the Eyedrapper
ool to create and apply colors and patterns. You will
also use the Control, Stroke, and Appearance panels to
change the weight, style (dashed or solid), alignment
(position on the path}, and endcaps of a stroke, and
create arrows.

Beyond this chapter, there are other fill and stroke
featuras to explore. in Chapter 12, you will create
nonuniform stroke widths using variable width profifes
and the Width tool; in Chapter 14, you will apply
multiple fill and stroke attributes; in Chapter 18, you
will apply colors with the Live Paint Bucket tool; in
Chagter 24, you will create and save gradients; and in
Chapter 29, you will use the Recclor Artwork dialog
to assign new colors or color groups to your'artwoyk.

Colors for your output medium
Before delving into the specific coloring features of
Htustrator, you need to know what types of colors
are suitable for your artwork and your target output
medium, .

Colors for print output
A solid color (also calied a spot coltor) is a predefined
mixture of specific inks that is printed via a separate
printing plate. To create PANTONE PLUS number 7489C
(a medium green), for instance, your print shop wouid
mix ink percentages of 60 ¢yan, 0 magenta, 80 yellow,
and 7 biack. To choose a solid color, you need to flip
through a printed guide for 2 matching system {(such as
the PANTONE PLUS Solid Chips guide); pick a named,
numbered color; then locate that color in Hlustrator.
You can use just solid colors if your document doesn't
contain any photos, gradients, ar other continucus-
tone elements, Each solid color incurs a cost, so
remember to factor that into your budget,

in commercial process printing, minute dots of the
four process colors— cyan (C), magenta (M), veliow (Y),
and black (K} — are printed from four separate pfates.
When viewing the print, your eyes (and mind) blur the
dots together ard read them as solid colors. {if you
examine a photograph in a magazine or catalog with
a magnifying lens or loupe, you will see the actual
dots.) You can choose premixed process coelors from
a matching system, such as TRUMATCH or PANTONE
PLUS Color Bridlge, or enter specific process color
percentages in the Color panet & or Color PickerB

GUICK ACCESS TO THE COLORING PANELS

To quickly open a color-related panel, either clickits
icon in a dock or use one of these methods:

Appearance | Press Shift-F6
panel 6
Color Shift-click the Fill or Stroke square
pane! &8 or arrowhead on the Control
panel® or click, then Shift-click
the Fiil or Stroke square on the
Apnearance panel; or press F6
J Swatches Ctick the Fill or Stroke square of
panel 2 arrowhead on the Control panel,
or click the Fill or Stroke square
E on the Appearance panel twice”

*When opened from the Control or Appeararice panel, these
panels stay open only temporatify.

& For print output, choose colors in the
CMYK coior model. CMYK colors can be
mixed on the Color panel ...

s it Bigkan o
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The four-color process printing method must be used if
your artwork contains continuous tones.f

In Hlustrator, you can create and apply nongloehal
process colors, which can only be edited individually in
selected objects, or global process colors, which can be
changed either individually in selected abjects or glich-
ally in alf objects in which they are being used {by edit-
ing the color swatch). This is explained on page 132.

if your budaget aliows, you can print a file using
process colors and alse add a solid (spot) color or two,
say, for a key graphic, such as a logo.

Colors for Web output

For Web and video output, you should either choose
RGB colors {percentages of red, green, and blue) or
enter hexadecimal codes. B Hexadecimal colors hex
colors for short) are coded using a total of six characters
from among the digits 0 through 9 and the letters A
through F. Following the hash symbot {#}, the first two
characters indicate the amount of red, the second two
indicate the amount of green, and the third two indi-
cate the amount of biue.

Note: For more accurate color matching between a
document that you view onscreen and the medium in
which it will be published, make sure you have chosen
the proper color management settings (see Chapter 2).

tn the New Document dialog (Advanced options show-
ing), when creating a document, you can choose CMYK
or RGB as the document color mode, Any colors you
mix or choose in that document will conform auto-
matically to the chosen mode. If you change the docu-
ment color mode, ali the colers in the artwork will be
converted to the new mode. Note that the gamut of
RGB colors is larger than the gamut of CMYK colors.
Note; If the final output for your file will be an
inkjet print (the inkjet print won't merely be used as
a mockup or proof before commercial proofing and
printing), choose RGB Color as the decumant mode.

To change the color mode of a document:

1. To be on the safe side, copy your file via the
File > Save As command (Cmd-Shift-S/Ctri-Shift-S).

2. Choose File » Document Color Mode > CMYK Color
{for commercial print output) or RGB Color (for
inkjet printing, or for Web or device output). The
current document color mode is listed in the docu-
ment tah,

If you need to reverse a document color mode
change, don't choose the former mode. Instead,

chotse EditD Undo :’mm%@ﬁfﬁfy’
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#4 The extended Info panel lists the compo-
nents or swatch name of the fill fon the left}
and stroke (on the right) in the currently
selected object. If multiple sefected objects
contain a nonmatching fill or stroke color,
that readout area will be blank.

IDesazr

B For Web output, use the RGE color
model or enter hexadecimal codes,

STAYING IN THE MODE

¥ You can create either process CMYK colors or
RGB colors in an Hlustrator decument, but not both.
Any process colors that you create in a document
will conform automatically to the current document
color mode, regardless of which mode you choose
for the Color panel {see page 117). This is also true
of the Color Mode menu in the Swatch Options
dialog when you edit a swatch (see page 132).

¥ Embedded placed and pasted images are
converted to the current document color mode
automatically.

EGNORING THE “OUT OF WEB” ALERT

When designing Web graphics, you don't need to
restrict yourself to Web-safe colors, which were for-
rrufated for earlier computer systems that couldnt
display millions of colors. Disregard the Out of Web
color warning & 6 if it appears in the Color panel or
Color Picket, and in the picker, keep the On[y Web
Coiors option uncheckad,
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Using the basic color controis

Note: To choose new default colors for future objects,
deselect all before choosing fill and stroke colors.

To apply a fill or stroke color, gradient, or
pattern via a temporary Swatches panel:

1.
2.

select one or more objects, or isolate an okject.
Do any of the following:

On the Control panel, click the Fill or Stroke square
or arrowhead, & then on the temporary Swatches
panei that opens, click a solid-color, gradient, or
pattern swatch.B—~ Note: in lllustrator C36, you
can apply a gradient to an olbject’s stroket P See
page 327.

On the Appearance panel,@g click the Fill or Siroke
listing, 8 click the color squara or arrowhead, B then
on the temporary Swatches panel, click a swatch.

B You can also change the stroke weight via the

Control or Appearance panel; see page 120.

To apply a fill or stroke color of None:

1.

Saelect one or more objects, or isolate an object.

2. Do one of the following:

On the Tools panel or the Color pane! %
Fill or Stroke square, then either click the Nene
button [ or press /.

On the Control panel, click the Fill or Stroke square
or arrowhead, then click the None button on the
temporary Swatches panel.

3

On the Appearance panei,.ﬁ@ click the Fil or Stroke

listing, then press /.

- AppeArRIce:

¢ Dafault .

o oBE o & o5 &
3 D .
% Click the Fill or Stroke listing on the
Appedarance panel,

Filf cp;’or Stroke color

s BB & 9 &

B We selected an object, clicked the
Fill square on the Control panel, then
clicked a color swatch.

B The new fill color
appedred in the object.

£ Next, we applied
a stroke color to the
same object.

I-- Apipanrahce

., B B = E D

B Ciick the Fill or Stroke square or arrowhead to open
a temporary Swatches panel, then click a swatch.

You ¢
the C

Toa
the

2.
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You can also apply a solid color to objects by using B If the fifl or stroke colors differ among selected
the Color Picker dialog or the Color Guide panel, objects, a quastion mark & appears in the Fil}
and/or Stroke square on the Tools, Colot, and

To apply a solid fill or stroke color using

| he Color Picker: Control panels. The new color you cheose will
. , _ apply to all the selected objects.
A 1, Select one or more objects, or isolate an object. :
t 2. On the Tocls or Color panel, double-click the Fill To apply a variation of & current coior via
or Stroke square. The Color Picker opens. the Color Guide panel:
3 Click a hue on the vertical bar in the middle of 1. Select one or more objects, or isolate an object.
the dialog (or drag the slider), then click a bright- 2. Onthe Tools or Color panel, click the Fill or Stroke
ness and saturation value of that hue in the square.
large square.f4 You can also define a color by ' 3. Display the Color Guide panel.l&

. B . .
antering HSB, RGB, hexadecimal, or CMYK values Click the Set Base Color to Current Color

If your document is going to be printed and the button [ in the upper left corner of the panel,
Out of Gamut icon & appears in the dialog, click then click a color variation swatch in the panelB
the swatch below the icon to replace the chosen For more about this panel, see pages 128-130.
cotor with the closest printable one.

4. Click OK,

e lolor Fleker oo

. setert Cotars

1 Color Swat'che;]i
. L..w_._ o]

APPLYING BLACK OR WHITE

- To apply a white fill and a black
stroke of 1 pt. to a selected object,
: L 4 click the Default Fill and Sticke

B In the Color Picker, click a hue on the vertical bar, then click a variation of that hution k8 on the Tools panal or
i color in the large square. press D.

Dlonky Web Cofors

¥ To apply 2 white or blaclfi

“or stroke separately to a selected
ohject, click the Filt or Stroke square
on the Color panel, then click the
White or Black selector on the Color
panel F (shown below) or click
the White or Black swatch on the

Swratches panel.

EH, Hoge & om

B On the Color Guide panel, click a

vanifion of the catvesitcolor.
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Saving colors as swatches

To save the colors being used in a
document as swatches:

The Swatches panel is used for storing and applying
process and solid colors, patterns, gradients, and
color groups. Swatches that you add to the panel
save only with the current file. To learn more about
this panel, see pages 124-127.

To save the current il or stroke coloras
a swatch:

1. Click the Fili or Stroke square on the Color 95
panel,

2. Do either of the following:

Sefect or isolate an object that contains the color
to be saved as a swatch.

Desefect, then choose a color via the Color Picker,
click a color on the Color Guide panel (see the
preceding page), or specify values via the Color
panel {see the facing page).

3. Display the Swatches panel so it stays open, &=
sither expanded in a dock or as a floating panel.

4. Hold down Option/Alt and click the New Swatch
button &4 on the Swatches panel -8B

B Torename a swatch, double-click it, then enter
a name in the Swatch Name field; or put the
panel into a list view {via the panel menu), then
double-ciick the name on the panei.“ﬁ(

Do either of the following:

Deseiect, then from the Swatches panel menu,
choose Add Used Caoiors.

Select one or more obiects, then from the Swatches
panel menu, choose Add Selected Colors.

Note: Both commands convert nonglobal process

colors & to global process colors & (see page 132).

L B Click the color
square on the
Color or Tools
panel, then
Cption/Alt click
the New Swatch
button on the

Swertches panel.

B The new
swatch appears
on the panel.

SHORTCUTS FOR COLORING OBJECTS

Toggle the Fill and Stroke Press X
squares {Tools and Color paneis)

the stroke color, or vice versa

Make the fill color the same as Drag one square over the other an the
Tools panet or Color panel

colors Stroke button o3

Swap the current fill and stroke Prass Shift-X or click the Swap Fill and

Apply a fill of Nene

Click the None button 7} on the Color
or Tools panel, or press /

Reapply the last solid cofor after | Click the Last Color button +8 on
applying a gradient, pattern, or the Color panel or the Color button
None on the Tools panel, or press <

Defatift —Ljg  *3-+— Swap Fili
Filtand and Stroke
Stroke (D) : (Shift-X}
Fill square”” | ® . Stroke
Color (<)-_| . square
T T None (/)
. on the Tools panel Gradient (> -
These color controls

are located at the bot-
tom of the Tools panel.

or None

Reapply the last gradient after Click the Gradient button 4 on the
applying a solid color, pattern, Tools panel, or press >

Vig
e
ou

To



Choosing colors via the Color panel
vVia the Color panel, you can choose an RGB or hexa-
decimal cotor for Web output or a CMYK color for print
output.

To apply a color via the Color panel:

1. Select one or more objects, or isolate an object—

B

or to choose colors for an object to be created,
deselect.

Do one of the following:
On the Color par‘nei,%%%= click the Fill or Stroke square.

On the Control panel, Shift-click the Fill or Stroke
square or arrowhead to open a temporary Color
panel.

On the Appearance panei,i@j{? click the Filt or Stroke
listing, then Shift-click the square or arrowhead for
that listing to open a temporary Color panel.

To choose a color for video or Web output, from
the Color panef menu, chocse RGB {not Web Safe
RGB). For greater accuracy in sampling, expand

the cotor spectrum bar by dragging the lower left
corner of the panel outward or by dragging the left
or bottom edge.‘&"ﬁ& Click a color in the spectrum
bar, then, if desired, tweak the color by moving the
sliders.

For video or Web output, from the Color panel
ment, choose RGB, then enter a hexadecimai value
in the # field. Note: You can copy and paste this
value into anather app%ication.‘ﬁ’

To define a specific process color for print output,
from the Color panel menu, choose CMYK. Refer
to a printed guide (such as a PANTONE PLUS Color
Bridge guide) for exact values, then enter C, M, Y,
and K percentages. B

Optional (but recommended): To save the new
color as a nongiobal process color swatch, Option-
click/Alt-click the New Swatch button % on the
Swatches panel,

To specify a shade on a gray spectrum, choose
Grayscale from the panel menu, Or to define a color
by hue (location on the color wheel), saturation
{purity), and brightness values, choose HSB.

To cycle through the color models for the Color
panel, Shift-click the spectrum bar at the bottom
of the panel.

Colors can also be defined numerically via the Color

Picker (g 1is)

¥
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& To expand the
Color panel, drag
the lower feft

corner {or the left
d or bottom edge).

¢ Color

panel menu, then enter percentage values.

SELTCTING TYPE OR A TYPE GBIECT
FOR RECOLORING

2= To recolor all the type in a block, select it with the
Selection tool or the Layers panel first,

¥ To recolor just a portion of the type in a block,
sefect that passage with a type tool first.

B To recclor an object that contains path or area
type {not the type), select the path with the Direct
Selection tool first,

SUBSTITUTING AN IN-GAMUT COLOR

If the current RGB or HSB celor has ne CMYK equivalent
{and therefore can't be printed on a commercial press),
an Cut of Gamut warning i displays on the Color
panel. If you click the icon or swatch, illustrator will
replace it with the closest eauivalent nrintable coior
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Using the Evedropper tool

When you click an object with the Eyedropper tool,
it samples the object’s color and stroke attributes,
displays them on the Color, Stroke, and Appearance
panels, and applies them to selected objects —in
one quick and easy step. Note: This too! doesn't pick
up or apply variable width profiles or brush strokes.

To sarmple and apply colors with the

Eyedropper tool:

1. Optional: To specify default settings for the
attributes that you want the Eyedropper tool to
pick up and apply, double-click the tool ¥ (or
click the tool, then press Return/Enter). In the
Eyvedropper Options dialog, check the attributes
that the tool is o pick up and apply (the default
setting is all options checked), uncheck the attri-
butes to be ignored, then click OK,

2. Optienal: Select one or more objects, They will
be recolored instantly with the attribiites you are
going to sampie with the Eyvedropper in step 4.

3. Choose the Eyedropper too! 7z (0.

4, Click an object in your artwork that contains
the desired attributes.f It can be any kind of
object (even a color in a placed image), and it
can contain a solid coloy, pattern, or gradient. The
object doesn't have to be selected. Depending
on the current Eyedropper Options settings, the
sampled colors may appear in the Fill and/or
Strake squares on the Tools, Color, Appearance,
and Control panels, and the sampled stroke
settings may appear on the Stroke panel,

If you sefected any cbjects before using the
Eyedrapper tool, the sampled attributes will be
applied to those objects. B

B Option-click/Alt-click an object to do the oppo-
site of the above —that is, apply color attributes
from the currently selected object to the object
you click &~E¥

#To have the Eyedropper tool sample just the color
you click in a solid color, gradient, or pattern (no
other attributes), click the Fill or Stroke square on
the Tools or Color panel, then Shift-click the color
to be sampled.

¥ To save the sampled color, drag it from the Fill or
Stroke square on the Color panel to the Swatches
nanel.
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& Select one or more
objects, then with
the Eyedropper tcol,
click an object that
contains the desired
attributes.

B The attributes
you sample will be
applied instantly to
the selected object(s).

& Ancther method
is to Option-click/
Alt-click with the
Eyedropper fool to
apply attributes

™ from the currentiy
sefected object to
the one you click.

E¥ This is the result
after we Option/
- Alt clicked with the
Eyedropper tool.
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Using the Swatches panel

Via the Swatches panel menu, you can control which
categories and size of swatches the panel displays.

To choose display options for the
Swatches panel:
1. Display the Swatches panel. 22

2. To control which categories of swatches display on
the panel, from the Show Swatch Kinds menu, B-
choose Show Ali Swatches for all types (colors,
gradients, patterns, and color groups),% Show
Color Swatches for just solid colors and color

“groups, Show Gradient Swatches for just gradients,
Shaw Pattern Swatches for just patterns, or Show

Color Groups for just color groups.

3. From the panel menu, choose a view for the
currently displayed category of swatches:
Small Thumbnail View, Medium Thumibnail View,
Large Thumbnail View, Small List View, or Large List
View. The medium and large thumbnail views are
useful for identifying gradients and patterns. In the
two list views, icons representing the cotor type
and mode for each sofid color also display.B

4, Optional: From the panel menu, choose Sart by
Name to sort all nongrouped swatches aipha-
betically by name or numericaily by their color
contents; or choose Sort by Kind (when ali swatch
categories are displayed) fo sort swatches in the
foliowing order: solid colors, gradients, patterns,
color groups.

B To locate a particular swatch, choose Show Find
Field from the panel menu, click in the field,
then start typing the swatch name. Choose the
command again to hide the field.

B You can drag a swatch, or muitiple selected
swatches, to another location on the panel. Colot
groups are always listed last.

- To learn the difference between global and
nonglobal calors, see page 132.

Global process Nonglobal
colors have a white  process colors  Spot colors

corner but no dot. are piain. have a dot.
| 1 -‘

Swatthes

8 Al four varieties of swatches {color, gradient,
pattern, and color groups) are displayed on this
Swatches panel becatise Show All Swatches s
chasen on the Show Swatch Kinds menu. (This
panel is int Medium Thumbnail view.)

Swatehes
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B When the Swatches panelis in a list view, icons
representing the color type and document cofor
mode display on the right side.
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A convenient way to organize swatches on the

. Swatches panel is by putting them in color groups. if

you're coordinating a group of solid colors for a specific
client, project, or whatever, you wil! be able to locate
and dispiay them more easily if they're in groups.

When the panel is in a thumbnail view, the colors
in each group are lined up in a row, beginning with
the folder icon, and each group name can be identi-
fied via its tool tip, When the panel is in a list view, the
name of the color group is listed next to the folder icon,
followed by a nested listing of the colors in the group.

To create a color group from swatches:
1. Deselect.

2. Onthe Swatches panel, iz Shift-click to select
contiguous solid-color swatches or Cmd-click/
Ctri-click to select multiple swatches (sorry, no
gradients, patterns, or the color None}.&

3. Click the New Color Group button at the
bottom of the panel.

4, In the New Color Group dialog, enter a Name, then
click OK. The new group appears on the Swatches
panel. &

Note: To add a swatch to an existing cotor group,
drag the swatch from the Swatches or Color Guide
- panel into the group or onto the group icon.

B You can also create a color group via the Color
Guide panel {see pages 128-130), the Kuler panel
{see page 131), or the Recolor Artwork or Edit
Colors dialog {see Chapter 29}. To edit any color
group via the Edit Colors dialog, double-click the
group icon on the Swatches panel.

¥ To rename a color group, click its icon, then choose
Cotor Group Options from the panel menu; or if
the panel is in a list view, double-ciick the group
name. ¥

B To restack a color group among other color groups,
drag its icon upward or downward.

To create & color group from artwork:

1. Seiect the artwork that contains the colors to be
put into a new color group.&

2. Click the New Celor Group button
Swatches panel.

oh the

3. Inthe New Color Group dialog, enter a name for

the group; click Selected Artwork; if desired, check
Convert Proress to Glohal and/nr Inclide Santrihac

for ‘Tg‘nffvs/ then click oKD
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Swatches

. -l

& With several solid-color swatches selected,
the New Color Group button is clicked.

B The new color group appears on the panel,

& We selected artwork
in o document, then
clicked the New Color
Group button on the
Swatches panel.

4 Swatches
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To copy swatchas between Hlustrator files:

1. Open the file into which you want to load anothey, or drag the object or group from one
" swatches. lfustrator document window onto the tab, and
2. From the Swatch Libraries menu s at the then into the window, of the other document. To
bottom of the Swatches panel, choose Cther append nonglobal process colors, do the same,
Library. The Select 2 Library to Open dialog then drag from the Fitl and/or Stroke square on
opens. the Color panel to the Swatches panel.
3. Locate and click the Hlustrator file from which
you want to copy swatches, then click Open. A
library of swatches opens, bearing the name of RESOLVING A SWATCH CONFLICY
the source file. = The Swatch Conflict dialog will appear as you
4. Inthe library pane! that was generated from the copy swatches or objects between files if a global
source file, do either of the following: process color has the same name as an existing
swatch In the current document, but different color
Click a swatch or color group icon.A~B percentages, Click Merge Swatches to have the
Crd-click/Ctel-click or Shift-click muitipie incorning swatch adept the color values of the exist-
swatches or click a swatch in a color group, then ing one, or click Add Swatches to add the incoming
choose Add to Swatches from the panel menu. swatch to the document {lilustrator appends a num-
5. Ifthe Swatch Conflict dialog appears, see the ber.to its name). Note: 1o apply.the current Qptions
) : setting to any other name conflicts that crop up and
sidebar at right. . prevent the alert dialog from opening repeateciy,
¥ To quickly append spot or global process colors check Apply to All.
from one file to another, do either of the follow- = if a conflict arises between spot colors, Hustrator
ing: Copy and paste an object or group that will merge the new swatch into the existing one.
contains thase colors from one dociment to

I
s SRR P
o B,

To
1.

To

A We opened a library of swatches from
another file, then clicked a color group.

Swvatchoy

. E &
B The color group appeared on the
Swatches panel for the current document.




To duplicate a swatch:

1.

On the Swatches panel, click the swatch to be
duplicated, then click the New Swatch button &
on the panel,

The New Swatch dialog opens. Change the swatch
name, if desired, check Global or not (see page
132), then click OK.

To bypass the dialog as you duplicate a swatch,
click the swatch, then Option-click/Alt-click the
New Swatch button (or drag the swatch over the
button).

To delete swatches from the panel:

1.

On the Swatches panel, == do one of the
following:

Click a swatch.
Click the icon for a color group.

Cmd-click/Ctrl-click (or Shift, then Shift-click)
multiple swatches or color groups,

To select only the swatches that aren't being used
in your artwork, choose Show Alf Swatches from
the Show Swatch Kinds menu,i% then choose
Select All Unused from the panel menu.

Click the Delete Swatch button % at the bottom
of the Swatches panel, then click Yes in the alert
dialog; or to bypass the prompt, Option-click/
Alt-click the Delete Swatch button.

{if you delete the swatch for a spot or global

process color {or for a pattern or gradient that
Contains a spot or global process color) that is
currently in use in your decument, a nonglobal
process color equivalent of the deleted color

is applied to those objects automatically (see
page 132}

To restore a swatch that you have just deleted,
choose Undo. If it’s too late to use the Undo

command but the deleted color is still in use in

your artwaork, select an object that contains the
color, click the Fill and/or Stroke square on the
Tools or Color panel, then Option-click/Alt-click the
New Swatch button on the Swatches panel. If the
swatch was a global process or spot color, you will
need to reset it to Global or Snot via the Swatch
Ogtions dialog (see page 132).

To restore swatches from a default library or any
other library, see pace 118.
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Swatches and color groups that you load onto the
Swatches pane!l will save with the current document
but will disappear from the panel if you repiace them
with another library (such as one of the default preset
libraries). Thankfully, you can collect the swatches and
color groups currently on the panel into a fibrary, for
access and use in any document.

To create a custom swatch library:

1.

Make sure the Swatches panel contains only the
swatches or color groups to be saved in a library.

B~ To delete all the swatches that aren't being
used in your artwork, choose Show All
Swatches from the Show Swatch Kinds
menu, B choose Select All Unused from the
Swatches pane! menu, then click the Delete
Swatch button. iif

From-thertop of the Swatch Libraries menu iy
on the Swatches panel, choose Save Swatches.

. The Save Swatches as Library dialog opens. Type a

namae far the library in the Save As/File Name fieid,
keep the default iocation, and click Save.
User~saved libraries are listed on, and can be

opened from, the User Defined submenu on the
Swatch Libraries menu.
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Using the Color Guide panel
Use the Color Guide panel to generate color schemes
from a base color by choosing a harmany rule and/
or a variation type (Tints/Shades, Warm/Cool, or Vivid/
Muted). You can apply any resulting swatch as a fill or
stroke color, save variations from the panel as a group
to the Swatches panel, and edit the current color group
via the Edit Colors dialog.

This panel might prove useful if you want to apply
a set of coordinated colors quickly, if your projects
require you to work with an approved group of colors,
or if you simply want to see how your artwork might
look in a different range of huss, tints, or saturation
values. To get acquainted with the panel, start by
choosing options for it.

To choose variation options for the Color

Guide panel:

1. Show the Color Guide panel i then choose Color
Guide Options from the panel menu. The Color
Guide Options dialog opens (formerly called the
Variation Options dialog, and now featuring a
percentage field *ﬁf}ﬁ_

2. Click the up/down arrow to set the number of vari-
ation Steps (columns of colors) to be displayed on
either side of the colors in the central column, and
move the Variation slider to control how much the
colors can vary from those in the central column.

3. Click OK.B

“# To make the swatches wider, enlarge the Color
Guide panel by dragging its left or right edge.

To apwply color variations via the Color

Guide panel:

1. From the Limit Color Group to Colors in Swatch
Library menu BEL at the bottom of the Color
Guide panei, chcose None.

2. To set the base color and initial variations, do either
of the following:

Select an object, & then click the Fill or Stroke
square on the Tools or Color panel. To have the
panel generate variations based on that fll or
stroke color, click the Set Base Color to Current
Color button [ in the upper left corner of the
Color Guide panei.

Deselect, click the Fili or Stroke square on the Tools
or Color panel, then click a swatch on the Swatches
panel or select a color via the Color panel.

Color Cutda Options..
Separpeid L

Variation: S

& In the Color Guide Options dialog, specify
the number of Steps (variation columns) to
be displayed on the Color Guide panel, and
a degree of Variation for those cofors.

Set Base Color
to Current Color  Base color  Active color group

CER, Mame g M

B The original colors from the active color
group display in the centraf column of the
Color Guide panel. The options for this panel
are set to 4 Steps (four cofumns on efther side
of the central one} and the maximum Yariation
percentage.

L We selected an object.
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3, The active color group displays at the top of
the Color Guide panel. To control what types of
variations are derived from the active cotor group,
choose a variation type from the panel menu:

& Color Guide

: show Tints/Shades adds progressively more black
. 1o the variations on the left side of the central

) i f column and progressively more white to the varia-
o : tions on the right.A

show Warm/Cool adds progressively mare red to
v : the variations on the left and progressively more
blue to the variations on the right.

these colors,
Show Vivid/Muted progressively reduces the

saturation of colors on the left and progressively
increases the saturation of colors on the right B

4. To apply a color variation, do either of the
following: _
To recolor the currentiy selected object, click a color E]] ID
in the active group at the top of the panel or click T e
a variation swatch in the main part of the panel.

S aipr Guide

Drag a variation swatch over any sefected or
unselected ohject.€

Note: When you click a variation on the Color Guide _ _
panel, that color appears in the Set Base Color W, Mome o _: CE M
to Current Color button.[B If you then click that SR S
button, the active color group changes and new
variations are generated.

B Here the Show Vivid/Muted option is chosen
instead.

¥ To limit the harmony and variation colors on the
Color Guide panel to colors in a library, from the

te Limit Color Group to Colors in Swatch Likrary
9“}” - menu, B choose a library name (e.g., Farthtone
AT or Color Books > PANTONE + Solid Coated). The
riation T s

library name will be listed at the bottom of the
Color Guide panel, and only colors from that library
will dispiay as variations on the panel and on

“ the Harmony Rules menu (see the next page). To
remove the current restriction, choose None from
tha same menu,

€ We dragged variation swatches from the Coior Guide
panel over a few of the objects in the artwork.
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Another easy way to change the variations on the Color
Guide panel is by choasing a harmony rule, such as
Complementary, Analogous, or High Contrast. A new
color group and vatiations are generated from the
same base color, in accordance with the chosen rule,
We could spend hours exploring the endless variations.

To create a color group and variations
based on a harmony rule:

. To estab!ish a base color on the Color Guide
pane%,ﬁgﬁ'fol!ow step 2in“To apply color variations
via the Color Guide panel” on page 128.

2. Onthe Color Guide panel, click to open the
Harmony Rules menu (to the right of the active
color group), & then click a rule. A new color group
displays at the top of the panel. Below that, you will
see the variations that lustrator generated from
the new color group. B

3. Optional: To produce a new color group and varia-
tions based on the chosen harmony rule, click a
variation or a color in the active color group, then
click the Set Base Color to Current Color button. &
You can also choose a different rule.

4. To recolor an object, select it, click the Fill or Stroke
square on the Color panel, then dick a color varia-
tion swatch, or drag a swatch over any selected or
unselected object.€

The color group and variations on the Color Guide
panel are transitory. They change as soon as you reset
the base color, choose a different harmony rule, or click
a swatch on the Swaiches panel. Thankfully, you can
save gither the active color group or selected variations
as a color group to the Swatches panel.

To add colors from the Color Guide panel
to the Swatches panel:

1. On the Color Guide panel, &
following:

. do efther of the

To save the active color grbup, deselect any
selected variations by clicking the blank area.

Cmd-click/Ctrl-click {(or click, then Shift-click) the
desired color variations.

2. Click the Save Color Group to Swatch Panel
button. £EI The new group appears on the
Swatches panel.

- To save a single variation instead of a coler group,

select it, then hold down Cption/Alt and click the
New Swatch button % on the Swatches panel.

& Codor Dubde

Tetead 2

L Tetrdd 2

Comuound £

Compound 2|

High Contrast B

High Contrast 2 '

High Contrast 3

High Cortrast 4

Fentagraen (723

# When you choose a harmony rule from
the menu on the Color Guide panel, the
base color stays the same, but the color
group changes to abide by the new rule.

Base color

CEL were @ 4@

& A new color group and variations appear
on the panel, based on the new harmony rule.

£ We dragged some new calor variations onto objects
in our arfwork.
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Replacing colors in your artwork
Via the Select Similar Cptions menu on the Control
panel, you can quickly select multipie objects that have
2 common attribute, such as the same fill color, then
apply a replacement color to all the selected objects.

To renlace a color, stroke attribute, or

opacity setting throughout a document:

1. Select an object that contains a spot color(s),
nonglobal process color(s), stroke weight, of other
attribute that you want to change, and that is also
in use in other objects.

2. From the Select Similar Options menu =
the Control panel, choose an option, such as Fill
Color, Stroke Color, or Fill & Stroke Color,

3. Tochange an attribute in the selected objects,
such as an attribute that you chose in the prior
step, do any of the following:

Click the Fiil or Stroke square on the Tools or
Color panel, then seiect a different color via the
Swatches, Color Guide, or Color panel, orin a
swatch jibrary panel. Tint percentages for spot
colors will remain the same.

Choose a new stroke weight or other stroke attri-
butes on the Stroke or Appearance panel,

Change the Opacity perceniage on the Control or
Appearance panel.

4. Deseiect (Cmd-click/Ctrl-click a blank area of an
artboard).

A global procass color swatch is cne for which Global
is checked in the Swatch Options dialog. When you
edit the values of a giobal process color swatch, the
color updates automatically in all objects in which

it is being used — whether or not those objects are
sefected.

To change a process color from nonglobal
to global:
1. Double-click a nonglobal process color swatch
on the Swatches panel, Note: Global process
cotor swatches have a white corner and no dot;
nonglobal process colers are plain (no corner and
no dot).

2. The Swatch Options dialog opens.f Check Global,
then click OK.

# To make a giohal swatch nonglobal, uncheck
Global in the Swatch Options diaicg.

To edit the values of 2 global process
coior

1. Double-click a global process color swatch on the
Swatches panel.

2. in the Swatch Options dialog, check Preview, edit
the color by maving the sliders, then click OK.
Existing tint percentages are preserved.

To replace a global process color that's being used in
multiple objects, instead of recoloring one object at a
time, you simply replace the current color swatch with
a new one, and the replacement color appears in all
the cbjects (even if they're not selected). Existing tint.
percentages are preserved.

To repiace a global process color swatch:
1. Deselect all objects. '
2. Do one of the following:

From the Swatch Libraries menu & on the
Swatches panel, choose a library name. Click a
color on the library panel, then Option-drag/
Ait-drag it over the giobal process color swatch
on the Swatchas panel that you want to replace.

Click the Fill or Stroke square on the Color panel,
then choose a new color via the Color panel (of
double-click either square and mix a color via the
Color Picker); or click a color on the Color Guide
panel. Option-drag/Alt-drag the Fill or Stroke
square over the giohat process color swatch on the
Swatches panel that you want to replace.

On the Swatches panel, Option-drag/Alt-drag
ona global colar swatch over ancther.
® If you Option-drag/Alt-drag a nongiobal process

color swatch over a global process swatch, the
resulting swatch will be a global process color.

—y

SwaeheDpHBNE oo aian by

- Swatch Name: | C=0 M50 =85 k=0 ]

: _f;qib_r'"_”l'.s;ﬁe_: Uprocess Cotar f
“ol CAciobal ) |

- Color Mode: [ CMYK i

B Double-click a swatch to open the Swatch
Options dialog, then check or uricheck Global.

in
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— new pattern-making features, Not only is it amazingiy
& simple to create patterns and apply them, but edit- g Objects drawn with the Blob Brush, Pencit, or
. e ing them is a cinch, too. lifustrator even takes care of Paintbrush tool, or a Live Paint group.
A : ' making seamiess repeats. Best of all, you can see your » Type (it will be editable in pattern editing mode;.
Y : changes live throughout the whole process. ¥ A raster image that you place into Hlustrator with
' To create a patiern: the Link option unchecked, such as a Photoshop psd
) file (see Chapter 22},
1. Select one or more illustrator objects {or a group).

Options panel displays.

Continued on the following page

Creating a pattern
If you tried to create patterns in a previous version
of IMustrator, you will be especially delighted by the

The objects may contain ill and stroke colors,
including a gradient (but not a pattern). For
suggestions, see the sidebar at right.

2. Do either of the following:
Choosa Object > Pattern > Make. The Pattern

Show the Pattern Options panel,'ﬁﬁ & then choose
Make Pattern from the panel menu.

The document is put into pattern-editing mode
{it's like isolation mode), B and a new pattern
swatch appears on the Swatches panel D

Patiers Options

-y .

PooE pgmer | Fitrs

Tile Tyme: | B Giig

I Bty Copies 10

N Show Tile Edpe

A We selected an object, then chose Make

Pattern from the Pattern Options panel ment,
The cartwnrk annonrod in the cueaterb An tho

Pane|
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car't be edited via the Symbols panel,

OBIECTS YOU CAN USE IN A PATTERN

= Geometric objects created with the Ellipse,
Rectangle, Polygon, Line, Spiral, Star, or Pen toal,

¥~ The expanded results of a tracing (see Chapter 17).
#= A clipping mask or a compound path.

¥ The objects may contain nondefault opacity and
blending mode settings (see Chapter 27),

- The objects may contain brush strokes {see
Chapter 23), symbols {see Chapter 28}, or effects {see
Chapter 15), but as an alert will inform you, thase
“ive" alements will be expanded by the pattern
feature. An expanded brush can't be edited via the
Brushes panel; an expanded symbol or symboi set

B The command also put
the document into pattern-
editing mode . ..

& nd rractord it nattorn canateh
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Note: By default, an alert will inform you that
lllustrator added the new swatch to the Swatches
Panel. Click "Don’t Show Again” if you want to
prevent the atert from reappearing; click OK.

F~ The blue (default color) tile edge in the center
of the arthoard defines the edge of the pattern
tile.

3. On the Pattern Options panel, do the following:

Enter a Name for the pattern.

From the Tile Type menu, choose a tiling
configuration.& If you choase a Brick option, also
choose a Brick Offset option.

4, Yo change the spacing between the tiles, check
Size Tile te Art, and if desired, click the Maintain
Spacing Proportions button. 5 Click in the
H Spacing or V Spacing field, then press the up or
down arrow on the keyboard (use a positive value |
to increase the spacing, or a negative value to : i AR :
decrease it).B B We chose the Hex by Column option from the Tile Type

menu.

5. |f your artwork contains muitiple objects, uncheck
Size Tile to Art, then try dragging an object, and
see how the pattern changes immediately in the
preview,

If you move any object so it overhangs the tile
edge, lustrator will replicate that object on the
opposite side of the tile, to create a continuous,
seamiess paitern. To controi the stacking posi-
tioh of the overhanging objects, click one of the
Overlap buttons in each pair: Left in Front or Right
in Front, and Top in Front or Bottom in Front (#A-I3,
next page).

Check Move Tile with Art to force the tile edge

te move if you drag ail the pattern object(s), or
uncheck this option when you need to move all
the objects separately from the tile edge.

Cont

6. To scale the tile separately from the artwork, do
either of the following:

To specify dimensions, uncheck Size Tile to Art;

if desired, click the Maintain Width and Height
Proportions button #a: to maintain the current
aspect ratio; then enter Height and Width values
(press Tab to apply) or click in either field and press
the up or down arrow,

B We increased the H Spacing and V Spacing values to 12 pt.

Click the Pattern Tile tool in the panel,f@ then
adjust any handle {(Shift-drag to maintain the
proporticns of the tile) (€, next page). When you're
done, click the tool again to deselect it
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¥ Shrinking the file will cause some objects Swatch boundary Tile edge
to straddie the tile edge. Double-check that /
you're stil! happy with the Overiap settings.

B At any time if you want to remove the custom
scaling and refit the tile edge to the objects,
check Size Tile to Art.

|
!
|
i
|

7. Forthe preview, do any of the following {these
options affect how the pattern previews, not how
it looks or repeats when used in your artwork]):

From the Copies menu, choose how many times
you want the pattern to repeat in the preview (the
default setting is 5 x 5}.

To make it easier to differentiate between the
actual object(s} used to produce the pattern and
the copies produced by the pattern feature, check

Dim Copies To, then enter or choose an opacity T C‘w&r} - v S
value {in £, the copies are dimmed to 60%). B 7o add some variation to the pattern, we duplicated the
Check Show Tile Edge to display the tile edge. original orange siice {group of objects} a few times, then

recolored some of the copies. We unchecked Size Tile to Art,
then dragged a couple of objects so they siraddled the tile
edge. This is the default Overlap option of Top in Front. {Here
Check Show Swatch Bounds to display a swatch both the tile edge and swatch boundary are displayed.)
boundary, which marks the cutermost area of

objects that will be repeated in the tile.

This option isn't available when the Pattern Tile
tool is selected.

8. To exit pattern-editing mode and acceptthe
swatch, at the top of the document window, click
Pone {or press Esc) or click the bar.

{To exit patiern-editing mode and delete the new
swatch from the Swatches panel, click Cancel)

Continued on the following page
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Note: If objects in the pattern contain “live”

appearancas, an alert may inform you that KEEPING THE PATTERN GPTIONS PANEL

llustrator must expand those items in order to UPEN
create a pattern swatch.ék If you click OK, the five By default, the Pattern Options panet closes
aspect of those objects will no longer be edit- when you exit pattern-editing mode (when you

click Done or Save a Copyh. To keep the panel
open even while you're not creating or editing a
pattern, uncheck Auto-Close on Exiting Edit Mode
an the panel menu.

able {e.q., a brush can't be edited via the Brushes
panel), but that's not necessarily a problem. if you
prefer to edit or eliminate any live items from the
pattern, click Cancel, edit or discard those abjects,

then exit pattern-editing mode. CHANGING THE PATTERN TILE EDGE COLOR
9. You can apply the pattern to any object as a fill & Ta change the color of the pattern tile edge,
and/or as a stroke (-8, next page). choose Tile Edge Color from the Pattern Options

panel menu {or choose Object > Pattern > Tile
Edge Color). In the dialog, choose a coler from
the menu, of click the swatch and choose a <olor
from the picker. To establish your color choice as
the new default color, check Use as Dafault.

B You can also create a pattern by choosing the
Make Pattern command with no objects selected,
then creating some artwork within the tiie edge.

Fidobe. E‘Jumcror

The paﬁam CatAng ACTVE x:an;ert !symbols ff‘ee:tﬁ pmqm gmups : i Parsern. T
L nested patierns of graphsythat must be expanded in ortder Lo create-a - SRS
L swiatchs 1P you-edit har pattem agam ia:ez ihe- ex;}andeu cement waii i : SR L
: e fanjer he acﬁ*.fe PRI USRI e i £a¥ar" Custon.. -] J !

CEdap Coich

'-;Dﬁ wu wani tﬂ mmmue? n::;mcei to swg i Fataern &dmnc Made) .- A w Use s D&f ke
g H L Ih

S E}m;(Showﬁgam S 4 cancel | i oK i IS :
: L s g [ - L Cancet j{ QK

B This alert informs you that your pattern artwork contains
live objects.

- Mé-ma{ ] Crawscale Texture

.T‘j]e:"flﬁ.}gjé £ Hex by Row

nght M 4151

. .-'L_LSE il 1o Are s

. Cagiss:

B You don't necessarily have to create geometric or hard- _ T e
edged patterns —you can aiso create textures. Loosely ol Do Coplester | 0
drawn paths (with brush strokes), top left, were used to T __Sf'sﬁ'_&w:frijé Fdge

cregte a pattel n, which is used as a fill in the Objﬁ’.c above o Shiow el Botnds
The pattern settings are showr on the panel at right. . : : R et
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Editing a pattern

Once you have mastered creating a simple pattern,

for added interest, try throwing in a few more objects,
transforming some of the objects, changing their
transparency seitings, or applying an effect. In pattern-
editing mode, all the controis are available that you

would normally use to edit objects in illustrator. You B
can reposition, reshape, recolor, or add a brush stroke
or variable width profile to any object, and add and
delete objects.
) o

To edit a patiern: ¥
1. On the Swatches panel, do either of the following:

Double-click a pattern swatch. B Some patterns (especially geometric ones) look best in
Click a pattern swatch, then cfick the Edit Pattern a basic grid {Tile Type option), with all the objects oriented
button. =1 vertically. If it's working, don't mess with it!

2. The Pattern Options panel displays and the docu-
ment is put into pattern-editing mode.

3. Optional:To preserve a copy of the original swatch,
click Save a Copy, enter a name in the New Pattern
dialog, then click OK. An alert may appear, inform-
ing you that the original pattern {not the copy) will
rerain onscreen, ready for editing. Click OK,

4. Edit the components of the pattern using any
Hlustrator features or tools:

Recolor or reposition any of the objects, or
apply transformation edits, such as scaling or
rotation. &1,

Add objects to the pattern. ;

Change any settings on the Pattern Options panet B The orientation, scale, and placement of these objects
as per steps 4-7 on pages 136-137 (e.g., decide is fairly uniform, which doesn't suit the naturalistic subject

whether you want Size Tile to Art on or off). matler.

Change the opacity {#—E next page) or biending
mode for any object via the Appearance panel; see
Chapter 27.

Apply an effect (€, next page); see Chapter 15. See
the Note in step 8 on page 138.

- The swatch thumbnail on the Pattern Options
panel updates as you edit the patterr.

Adjust the stacking of objects that straddle the
tile edge via the Overlap buttons on the Pattern
Options panel {or via the Layers panel).

5. To exit pattern-editing mode and apply your edits
to the swatch, at the top of the document window,
click Done (or press Esc) or click the bar.

A C—

# You can load and edit patterns from any lltustrator € Some objects were repositioned ta extend beyond the tile

. ' : d . .
library. To copy pattern swatches between edge, and some were ratated or s.caied Better.
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Hiustrator documents, see the steps on page 126

{or for a quick approach, copy and paste an object REPOSITIONING A PATTERN IN AN OBJECT
that coniains a pattern from one document to To reposition a patiern fill or stroke within an object
another). Pattern swatches from previous versions while keeping the object stationary, hold down ~
of Hllustrator can be edited using the Pattern {tilde) and drag inside it with the Selection tool. To
Options panel in tilustrator CS6. learn about settings for transforming patterns, see

. ) . the sidebars on pages 147 and 148,
¥ Any object that you want to include in a pattern

must be situated at least partially within the tiie
edge. lllustrator won't discard any objects that are
fully outside the tile; they just won't be included.

¥ If you're having trouble seeing the edits you're

D making to selected ohjects in patiern-editing

i C mode, hide the selection borders tempararily by
g pressing Cmd-H/Ctri-H (View > Hide Edges). Be sure

{ : : o re~enable the display of edges when you're done.

& This is the
original pattern.

Y
]

B We lowered the Cpacity setting for some of the objects in € We applied the Roughen effect to all the objects fand

. P FE
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Rlank areas in a patiern are transparent. & In fact, this
can be an asset if you want to layer multiple pattern fills
in separate objects in your artwork, On the other hand,
if you want to build an opaque, solid-colored back-
ground into the pattern, follow these steps.

To add a background to a pattern: %

1. Onthe Swatches panel, do either of the following:
Double-click a pattern swatch,
Click a pattern swatch, then click the Edit Pattern
button. B

2. With the Rectangle tool, raw a rectangle to fit
the tile edge. To prevent gaps from appearing in the
pattern, let it overhang the tile edge siightly on the
top or bottom and on one side. Apply a fill coler.

3. With the rectangle selected, on the Layers panel,
drag the rectangle listing downward to the bottom-
most position in the stack of pattern objects.

4. Because the background object extends to the tile
edge, Hllustrator will calculate it as part of the over-
lap, and parts of other objects that overhang the
tile edge may become biocked. B To prevent this
from happening, make sure no objects straddle any
corners of the tile edge (in other words, an object
can extend off only one side).&

5. To exit pattern-editing mode and apply your edits
to the swaich, at the top of the document window,
click Done (or press Esc) or click the bar,

B ifyou add a colored background object that meets the
tile edge, some parts of objects could be hidden due to
overfap fimitations,

& Empty areas in a pattern are transparent. An agua blue
object is stacked behind an object containing a pattern fifl

© For the best results when adding a background, allow
objects to overhang the tile edge on just the left or right
edge or just the top or bottom edge.
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